Institute Proposal, Award, and Subaward Modules Basics

Need help? Contact coeus-help@umd.edu

File Name: Basicswithsubawards.doc
Last Revised: March 2015
# Table of Contents

**GETTING STARTED** ......................................................................................................................... 1

  - **COEUS MAIN SCREEN ICONS** ........................................................................................................ 2
  - **COEUS MAIN SCREEN MODULES** .................................................................................................. 3
  - **COMMON SEARCH TECHNIQUES** ................................................................................................. 4
  - **SORTING MULTIPLE COLUMNS IN THE SEARCH RESULT WINDOW** ............................................. 10
  - **SAVING SEARCHES AS EXCEL FILES** .......................................................................................... 11

**UNIT HIERARCHY** ............................................................................................................................. 13

**PERSONNEL** .................................................................................................................................... 16

  - **PERSON DETAIL TABS** .................................................................................................................. 17
  - **CURRENT AND PENDING REPORT** .............................................................................................. 19
  - **SAVE AS FEATURE** ........................................................................................................................ 20

**AWARD MODULE** ............................................................................................................................. 22

  - **AWARD SEARCH SCREEN ICONS** ............................................................................................... 23
  - **AWARD MODULE SEARCH WINDOW** ........................................................................................... 25
  - **AWARD MODULE TABS** ................................................................................................................ 26
  - **AWARDS – INDIRECT COST AND COST SHARING** ....................................................................... 32
  - **PRINTING AWARD NOTICES & DELTA REPORTS** ....................................................................... 33

**INSTITUTE PROPOSAL** ....................................................................................................................... 38

  - **INSTITUTE PROPOSAL SEARCH** .................................................................................................... 39
  - **INSTITUTE PROPOSAL TABS** ......................................................................................................... 41

**MEDUSA** ........................................................................................................................................ 45

**SUBCONTRACT MODULE** .................................................................................................................. 46

  - **SUBCONTRACT ICON MENU BAR** ............................................................................................... 48
  - **SUBCONTRACT SEARCH (SUBAWARD)** ...................................................................................... 49
Getting Started

Install Coeus to begin. Installation instructions can be found here: Coeus Installation Guide

Double click the COEUS Icon on your desktop:

A pop-up window prompting you to enter your username will appear (please use your UMD ID). Once you have entered your username, click OK:

A second pop-up window will prompt you to enter your password (please use your UMD ID associated password). Once you have entered your username, click OK:

The Coeus Message window will pop-up upon a successful log in. Any important Coeus-related messages will appear in this window. You may check the Do not show this message again box to remove the pop-up message upon logging into Coeus. Click OK *.
*NOTE: If you choose to not show the Coeus Message, you will no longer get the current pop-up message. You will however, receive any future messages that are different than the current displayed message.

Coeus Home Screen:

Coeus Help Contact Information:

Coeus Help Contact:

Email: HUcoeus-help@umd.eduU

Phone:
Lauren Bradley, lbradle1@umd.edu, ext. 59743
John Down, jdown@umd.edu, ext. 56263
Sally Egloff, HUsegloff@umd.eduUH, ext. 58060
Zach Friedman, HUzif@umd.eduUH, ext. 50164
Kurt Flick, kflick@umd.edu, ext. 56270
Carolyn Miller, cmille14@umd.edu, ext. 54179

Coeus Main Screen Icons

The Coeus main screen icons (aka Modules) are located at the top of the home page:
### Coeus Main Screen Modules:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Module Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Maintain In Box</td>
<td>Contains notifications sent to your user account. These are typically used for electronic routing and approval of proposals as of summer of 2011.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Maintain Award Module</td>
<td>Contains award information – sponsor award number, accounts, mods, investigators, credit split information, invoicing information (OCGA), terms, reports, special review items, award notices, delta reports (ATSs).</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Maintain Institute Proposal Module</td>
<td>Contains information about proposals that have been submitted to sponsors – status, investigators, indirect costs, cost sharing, special review, current and pending reports, etc.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>Maintain Proposal Development Module</td>
<td>Proposals are created in this module – includes budgets, proposals, investigators, special review, etc. Proposals are electronically routed, approved and can be electronically submitted to sponsors via Grants.gov. Implementing fall of 2011.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>Maintain Rolodex</td>
<td>Contains specific contact information about organizations (Subawardees), sponsors and investigators who are not affiliated with UM.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>Maintain Sponsors</td>
<td>Contains information about the sponsors that have been entered in Coeus. Some of these came with the MIT install, RAA sponsors and new sponsors added since fall 2007.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>Maintain Subcontracts</td>
<td>Contains subcontract information, subaward type, start/end dates, title of project, subawardee audit information, KFS account numbers, etc.</td>
</tr>
<tr>
<td><img src="image8.png" alt="Icon" /></td>
<td>Maintain Person</td>
<td>Contains information about faculty and staff at UM. Populated from a feed from PHR.</td>
</tr>
<tr>
<td><img src="image9.png" alt="Icon" /></td>
<td>Maintain Unit Hierarchy</td>
<td>Shows the structure of UM at College Park as it relates to colleges/schools and the departments in them. Contains business administrator information about each department.</td>
</tr>
<tr>
<td><img src="image10.png" alt="Icon" /></td>
<td>Exit</td>
<td>Allows the user to exit the Coeus System.</td>
</tr>
</tbody>
</table>
Common Search Techniques

All Coeus search screens use the same techniques:

1. Launch the module you want to navigate by clicking the associated icon or selecting a module through the menu options:

   a. Launching a module by clicking a module icon*:

   b. Launching a module through the menu options:

   *NOTE: The module name will appear by hovering over the module icon.

   b. Launching a module through the menu options:

2. How to launch all main screen icons:

   a. **Institute Proposal** - Click the icon that looks like 2 pieces of paper or choose the menu **Maintain → Institute Proposals**.

   b. **Award** - Click the icon that looks like a yellow diamond or choose the menu **Maintain → Awards**.

   c. **Person** – Click **Maintain Personnel** icon or choose the Menu **Departmental → Personnel**.

   d. **Unit Hierarchy** – Click **Maintain Unit Hierarchy** icon or select the Menu **Admin → Unit Hierarchy**.
3. A search window will appear:

4. Once you have clicked the desired Module icon and the search window appears, enter search criteria such as word(s), number(s), etc. into their associated blank cell(s) and click **Find**. Search criteria may be entered as follows:
   a. Exact search from a drop down menu within Coeus (see Example 1);
   b. Part(s) of the search criteria with a wildcard asterisk * (a star-shaped symbol by holding **Shift**+8; For example: *foundation*, cancer*, *evaluation* (see Examples 2, 3, 4, and 10);
   c. Apply an AND search condition, use multiple columns in the same row; For example: Status>Pending, Title> *nano* (see Example 5);
   d. Apply an EITHER/OR search condition, use multiple rows;
      For example: enter *corporation* in the first blank cell under the ‘Sponsor Name’ column and type *incorporated* in the blank cell underneath of where you typed *corporation* (see Example 6);
   e. Search within a certain period of time;
      For example: Searching for proposals in FY 2007 where the PI is Dr. Mosser, you would type 07* in the Proposal Number column and *mosser* in the Investigator field (see Example 7);
      *NOTE: All proposal numbers in Coeus begin with the two-digit fiscal year. If it is fiscal year 2014, then your proposal number would begin with 14*;
   f. Title contains two specific words;
      For example: a title which contains the words in the order of food and nutrition, type in *food*nutrition* or *food**nutrition* or *food* *nutrition* (see Example 8);
      *NOTE: The order of words **DOES** matter;
   g. Exact search for a person;
      For example: type in the exact last name of the person you are trying to find in Coeus under the Last Name field-no asterisks (see Example 9);
   h. Unit search by unit (department name);
      For example: search for a unit number for ‘Psychology Department’ by typing *psychology* in the Unit Name field (see Example 10).
5. Once the search result is listed, double click the line you want to open up for details*.

*NOTE: You can determine which search result detail is being displayed by reading the title of the window pane.
To continue searching for another record, close the record currently open by clicking the ‘x’ in the upper right corner. Once the search record has closed out, click on the Search Icon or select the Menu Option: Tools → Search.

Example 1: Exact search from drop down menu
To search for funded proposals, select Funded from the Status field and click FIND
**Example 2:** Contains a word or string
To search for proposals whose sponsor names contain the word ‘foundation’, type *foundation* in the Sponsor Name field and then click **Find** button.

**Example 3:** Begins with a word or string
To search for proposals with a title that begins with the word ‘cancer’, type cancer* in the Title field and click **Find** button.

**Example 4:** Ends with a word or string
To search for proposals with a title that ends with the word ‘evaluation’, type *evaluation in the Title field. Click **Find** button to start searching.

**Example 5:** Multiple criteria (single row invokes logical AND)
To search for all pending proposals with the word ‘nano’ in the title, select Pending from the drop-down menu in the Status field and type *nano* in the Title field. Click **Find** button to start searching.
**Example 6:** Either/OR criteria (multiple rows invoke logical OR)
To search for all proposals whose sponsor names end with ‘corporation’ or ‘incorporated’, type *corporation* in the Sponsor Name field of first row and type *incorporated* in the Sponsor Name field of second row. Click Find button to start searching.

**Example 7:** Certain period of time
To search for the proposals submitted in FY07 by PI Dr. Mosser, type in 07* in the Proposal Number field and *mosser* in the Investigator field. Click Find button to start searching.

**Example 8:** Contains two specific words in the title
The order of words does matter. To search for proposals whose title contain words ‘food’ and ‘nutrition’, type in *food*nutrition* or *food* nutrition* or *food**nutrition* in the Title field. Click Find button to start searching. The search will find proposals only where ‘food’ comes before ‘nutrition’ in the title.
Example 9: Exact search for a Person.
To search for people whose last name is ‘fenselau’, type in the exact name *fenselau* in the Last Name field. If you have the exact word to search by, you do not need to use wildcard (*). Click Find button to start searching.

Example 10: Unit search by unit (department) name
To search unit number for ‘Psychology department’, type in *psychology* in the Unit Name field and click Find button to start searching.

Sorting Multiple Columns in the Search Result Window

You can sort by choosing File > Sort from the menu bar or click on the icon.
The sort window appears. Choose the column(s) for your sort by dragging them from the left column to the right hand column in the order you wish to conduct your multiple sort.

Example: Sort by Lead Unit, then Proposal No., then PI. The multiple sort window defaults to Ascending sorts. To sort in Descending order, click in each box to remove the checkmark. Click OK.

Saving Searches as Excel Files

You can save searches as an Excel file by following the same steps on pages 23-24. After performing a search for particular criteria, your results will display:
1. To Save, choose from the following three options: Menu Bar: **File ➔ Save As**, click on the floppy disk icon, or use Ctrl-S.
2. Choose the location where you want to save the file in.
3. Type in your file name and leave the default **XLS** as **Files of type**.
4. Click **Save**.

Double click on the file to open it in Excel. This allows the end user to add/delete columns, perform mathematical calculations, draw chart and graph, etc.
Unit Hierarchy

Click **Maintain Unit Hierarchy** icon or select the Menu **Admin → Unit Hierarchy**.

Click **Search** icon to launch Unit Search window.

Available search criteria for Unit Hierarchy:

- **Unit Number**: 7-digit number. First 3 numbers represent the College or School. Sometimes displayed as **Department Number**.
- **Unit Name** – sometimes displayed as **Department Name**
- **Administrative Officer**: currently not in use
- **Unit Head**: currently not in use
- **Dean VP**: currently not in use
- **Other Ind To Notify**: departmental business contacts
- **OSP Administrator**: Contract Administrator in ORA assigned to the unit.

Use search techniques to find a unit
Click and highlight the finding, then click **OK** button.

The unit number you searched for will be highlighted within the list.
To see the unit details such as Contract Administrator and Departmental Contact list, click and highlight the Unit found, then click **Display unit details** icon.

The **Administrators** tab displays departmental contact(s) who will receive Award Transaction Notification emails sent from Coeus.

**Osp administrator** = Contract Administrator at ORA. Double-clicking the name will open up the Person Details window.
Personnel

Click Maintain Personnel icon or choose from the menu bar Departmental → Personnel. You will be able to look up UMD Faculty and Staff information that are fed from PHR system.

Available search criteria for Person Table:
- Last Name
- First Name
- Full Name
- **User Name** - if user has an account in Coeus, then this is the directory ID at UM
- **Email** - email listed as primary email account in PHR.
- **Department Number**
- **Unit Name**
- **School**
- **Directory Title**
- **Office Location**
- **Office Phone**
Person Detail Tabs

Organization tab

![Organization Tab]

Personal tab

![Personal Tab]
Contact Info tab

Misc. tab
Current and Pending Report

In order to run a ‘Current and Pending Report’ for an investigator, you first need to search for the investigator in the Person Search.

Once the search result screen appears, click and highlight your finding then click Current and Pending Report icon (or select from the Menu: Edit → Current and Pending Report).

Or
Current Support tab

Pending Support tab

Save As Feature

The Save As feature allows you to export a current and/or pending report into an excel document in a location of your choice. You can save the Current Report, Pending Report, or both by using the Save As button or select from the Menu: File → Save As.
A new window will open asking if you would like to save the Current Report, Pending Report, or Both. Click **OK**.

![Image of Current/Pending Report window]

Windows Explorer will open, select a location of your choice to save the report. Click **Save**.

![Image of Windows Explorer save dialog]

Your report is now exported into a spreadsheet format in your desired location and will appear as an excel icon. Double click the icon and your report will open via Excel.

![Image of Windows desktop with Excel file]

*NOTE: You have the ability to export search results in the additional module: Institute Proposal, Awards, and Subawards*
Award Module

Click the *Maintain Awards* icon or select the Menu *Maintain ➔ Awards*.  

Or
### Award Search Screen Icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Create New Award" /></td>
<td>Create New Award</td>
<td>Use to create an initial award. <strong>ORA Only</strong></td>
</tr>
<tr>
<td><img src="image" alt="Correct Award" /></td>
<td>Correct Award</td>
<td>Used to make changes in an award. <strong>ORA Only</strong></td>
</tr>
<tr>
<td><img src="image" alt="Display selected Award" /></td>
<td>Display selected Award</td>
<td>Opens the award in display mode. Doesn’t allow for any changes.</td>
</tr>
<tr>
<td><img src="image" alt="Award New Entry" /></td>
<td>Award New Entry</td>
<td>Opens the Award New Entry window with a new entry or sequence number. <strong>ORA Only</strong></td>
</tr>
<tr>
<td><img src="image" alt="Award Hierarchy" /></td>
<td>Award Hierarchy</td>
<td>Display the Award Hierarchy for the selected award. Shows the parent account and any associated child accounts.</td>
</tr>
<tr>
<td><img src="image" alt="Notepad" /></td>
<td>Notepad</td>
<td>Opens the Notepad window and allows the user to add a comment and restrict viewing of the note.</td>
</tr>
<tr>
<td><img src="image" alt="Reporting Requirements" /></td>
<td>Reporting Requirements</td>
<td>Displays the required reports for an award. Can be edited to indicate change in status, date sent, etc.-ORA only. Departments should always refer to the award document for complete reporting information.</td>
</tr>
<tr>
<td><img src="image" alt="Medusa" /></td>
<td>Medusa</td>
<td>Opens the Medusa window-Award,Subaward, Institute Proposal and Development Proposal links to show the relationships among them</td>
</tr>
<tr>
<td><img src="image" alt="Sort Awards" /></td>
<td>Sort Awards</td>
<td>Opens the Sort window and allows for sorting multiple columnar contents- ascending and descending</td>
</tr>
<tr>
<td><img src="image" alt="Award Summary" /></td>
<td>Award Summary</td>
<td>Displays a summary of the selected item</td>
</tr>
<tr>
<td><img src="image" alt="Search" /></td>
<td>Search</td>
<td>Opens the Select Award window so users can search for awards</td>
</tr>
<tr>
<td><img src="image" alt="Save As" /></td>
<td>Save As</td>
<td>Exports data into a MS Excel Spreadsheet format</td>
</tr>
<tr>
<td><img src="image" alt="Close Award" /></td>
<td>Close Award</td>
<td>Closes the current award window</td>
</tr>
</tbody>
</table>
Once an Award has been selected from the Search screen and opened, the following icons appear:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next</td>
<td>Displays the next award</td>
</tr>
<tr>
<td>Previous</td>
<td>Displays the previous award</td>
</tr>
<tr>
<td>Print Award Notice</td>
<td>Opens a window and you select the items you wish to print as part of the award notice</td>
</tr>
<tr>
<td>Notepad</td>
<td>Opens the Notepad window and allows the user to add a comment and restrict viewing of the note.</td>
</tr>
<tr>
<td>Reporting Requirements</td>
<td>Displays basic reports for an award. Can be edited to indicate change in status, date sent, etc.-ORA only. Departments should always refer to the award document for complete reporting information.</td>
</tr>
<tr>
<td>Medusa</td>
<td>Opens the Medusa window-Award, Subaward, Institute Proposal and Development Proposal links to show the relationships among them</td>
</tr>
<tr>
<td>Save As</td>
<td>Exports data into a MS Excel Spreadsheet format</td>
</tr>
<tr>
<td>Close Award</td>
<td>Closes the current award window</td>
</tr>
</tbody>
</table>

File | Details | Maintain | Departmental | Admin | Report | Window | Help |

Insert image of the icons mentioned in the text.
Award Module Search Window

The following search window appears when you open *Maintain Awards*:

You can search for an award by any of the following fields:

- **Sponsor Award Number**: Award number provided by sponsor (omitting dashes and spaces)
- **Award Number**: Coeus generated number. 6-digit number followed by -001, -002 and so on. (e.g. 006052-001 is a primary or parent account. 006052-002 is a child account of 006052-001.)
- **Account Number**: 7-digit KFS number (omitting the leading 01)
- **Award Status**: Approved, Returned, Sent to OCGA, Inactive, Closed, Pending within ORA
- **Award Type**: Grant, Contract, Cooperative Agreement, Intergovernmental Personnel Assignment, and non-monetary awards such as Material Transfer Agreement, Non-disclosure Agreement, Teaming, Equipment Loan, Memorandum of Understanding, Indefinite Delivery Contract
- **Sponsor Code**: 6-digit computer generated number
- **Sponsor Name**
- **Prime Sponsor**
- **Award Title**
- **Investigator Name – PI or Co-PI**
- **Unit Number**: also referred to as **Department Number**
- **Unit Name**: also referred to as **Department Name**
- **OSP Administrator**: Contract Administrator at ORA
- **Obligation Effective Date**: the begin date of the award per the award agreement
- **Final Expiration Date**: the end date of the entire project
- **Execution Date**: the Effective/Fully Executed date the sponsor committed the award as found on the award document
- **Sub Plan Flag**: Indicates whether a subcontracting plan is required on a Contract. Used by Procurement
Award Module Tabs

Search for an award by entering information in any of the blank fields in the Award Search window. Click Find.

To open the award details, either highlight and double click the Award you want to display or highlight and click the display details icon. Or

Double click the award you want to open
This will open the *Display Award* screen:

*Award Detail* - Summary information about the award. Each award action is called a *Sequence*. By looking at the top line you see how many award actions have taken place. On the screen below there have been 3 sequences.
Other Header (contains billing information for OCGA) If there is a **Prime Sponsor**, it is indicated on this tab.

### Money and End Dates

- **Award Transaction Type** – Indicates action taken (Initial/New, Transfer/Credit, Transfer/Debit, No Cost Extension, Credit Split Change, etc.)
- **Coeus award number (015010-001)**: Parent ends in 001. The seven digit number (525375) is the KFS number.
- **History button** shows you the history of the money added/transferred in or transferred out/reduced.
- **Action Summary** shows a list of all actions on this account.
Contacts – Contains OCGA contact info for the person handling this range of accounts, as well as any other contact information such as the agency Technical Officer, the agency Grant Officer, etc. added to Coeus.

Reports – Contains standard report requirements for this award. *Always refer to your award document for the reporting requirements.*

Terms – Contains terms for the 9 categories on the left side of the screen. *Always refer to your award document for the terms and conditions of the award.*
Special Review – Contains information on the items under Special Review (example IRB, IACUC, export control, conflict of interest, etc.)

Investigator – Contains PI name and departments. Lead PIs and Lead Units are indicated by check marks. By double-clicking on a person’s name you will see a window that contains their office location, phone number, etc.

You can view the credit split information by clicking on the Credit Split button located to the right hand side of the page (see above).
Credit Split Window

Comments – All comments are contained in the General Comments section. To see previous comments, click on the History button.

Subcontracts – If there are any subawards associated with this award, they will be listed on the Subcontracts tab.

Dark lines indicate Project Credit. Rows showing the unit (department code) indicate departmental credit. Example: Physics will get 100% of Dr. Breuer’s 50% credit.

To see the sub award in Coeus, you can double click on the line of information.
Attachments – Effective in FY 11, As of July 12, 2010, all award actions that contain backup documentation will have the documents attached in PDF format. To access these documents UMD faculty and staff will need to have an account set up in Coeus. **All faculty and staff must complete a UM Coeus Account Request form and have it signed by their Department Head. In addition, Administrative Staff must attend Coeus Basics training.**

To view these attachments click on the Adobe icon and the documentation will display in your browser window. You will need a current version of Adobe Reader installed on your computer.

![](image)

Awards – Indirect Cost and Cost Sharing

*NOTE: You much have the ‘Display Award’ window pulled up in Coeus in order to have the ‘Details’ option appear on the Menu bar.*

From the menu bar choose **Details.** You can select ‘Cost Sharing’ or ‘Indirect Cost Sharing’ from the ‘Details’ menu.

![](image)

Cost Sharing – Click on **Cost Sharing** to see that window.
Indirect Cost Rate (aka F&A rate) – Click on Indirect Cost to see that window.

Printing Award Notices & Delta Reports

How to look at prior Sequences (ATSs) in Coeus:

In the ‘Display Award’ window, click the Money and End Dates tab, then click the History button.
The list of Award Sequences will display.

If the award action creates an *Initial/New* account it will be **Sequence 1**. This sequence 1 is called the ‘*Award Notice*’. To print sequence 1, select from the Menu bar: **File > Print Award Notice**.

If the sequence number is greater than one (example: sequence 2, sequence 3, etc.), these are considered ‘*Delta Reports*.’ To print a Delta Report (aka sequence numbers greater than 1) select from the Menu bar: **File > Print Delta Report**.
A “counter” window appears. It contains the most recent sequence and action. (This means it includes edits). Always use Amount Sequence No. 1. In the Sequence No field, select the sequence number you wish to print.

Example: Award sequence 2 has 9 actions associated with it. The only one that feeds to BARS is the first action. In order to print the Delta report for this award number, choose Print Delta Report from the File menu.
After choosing **File-Print Delta Report** the window below appears. In order to get the correct Delta Report for the award sequence, choose the sequence you want by using the down arrow in the **Sequence No.** box.

If the number in the **Amt. Sequence No.** box is greater than 1, use the down arrow to get to **Amt Sequence No. 1**. Then click **Print**.

**NOTE:** To determine the Administering Department, look for ‘(LU)’. The lead PI is designated by (PI) after the lead PI’s name. These reports generate as PDFs so they can be saved or printed out in hard copy.
**Delta Report:**

<table>
<thead>
<tr>
<th>FRS Account Number:</th>
<th>525375</th>
</tr>
</thead>
<tbody>
<tr>
<td>Investigator:</td>
<td>Cernub RR Hooks (PI)</td>
</tr>
<tr>
<td></td>
<td>Amy E. Brown</td>
</tr>
<tr>
<td></td>
<td>Gerald Edward Brust</td>
</tr>
<tr>
<td></td>
<td>Jon H. Trautfeld</td>
</tr>
<tr>
<td></td>
<td>Karen K. Rane</td>
</tr>
<tr>
<td></td>
<td>Kathryn L. Everts</td>
</tr>
<tr>
<td></td>
<td>Michael J. Raupp</td>
</tr>
<tr>
<td></td>
<td>Paula M. Shrewsbury</td>
</tr>
<tr>
<td></td>
<td>Stanton Andrew Gill</td>
</tr>
<tr>
<td></td>
<td>Sudope A. Mathow</td>
</tr>
<tr>
<td></td>
<td>Lauren Kolb *</td>
</tr>
<tr>
<td>Unit:</td>
<td>CMNS-Entomology</td>
</tr>
<tr>
<td>Sequence 2:</td>
<td>1365001:</td>
</tr>
<tr>
<td></td>
<td>1251301: AGNR-U.M.E-Region II (Ob)</td>
</tr>
<tr>
<td></td>
<td>1365001: AGNR-U.M.E-Home and Garden</td>
</tr>
<tr>
<td></td>
<td>1360501: CMNS-Entomology</td>
</tr>
<tr>
<td></td>
<td>1360501: CMNS-Entomology</td>
</tr>
<tr>
<td></td>
<td>1251701: AGNR-U.M.E-Home and Garden</td>
</tr>
<tr>
<td></td>
<td>1365001: CMNS-Entomology</td>
</tr>
<tr>
<td></td>
<td>1365001: CMNS-Entomology</td>
</tr>
<tr>
<td></td>
<td>1251301: AGNR-U.M.E-Region II (Ob)</td>
</tr>
<tr>
<td></td>
<td>1365001: CMNS-Entomology</td>
</tr>
<tr>
<td>Sponsor:</td>
<td>USDA-National Institute of Food and Agriculture</td>
</tr>
<tr>
<td>Award Number:</td>
<td>015010-001</td>
</tr>
<tr>
<td>Title of Project:</td>
<td>Increasing the Partnerships Multi-Disciplinary</td>
</tr>
<tr>
<td>Begin Date:</td>
<td>09/01/2010</td>
</tr>
<tr>
<td>Expiration Date of Current Obligation:</td>
<td>06/31/2012</td>
</tr>
<tr>
<td>Change to Distributable Amount:</td>
<td>41,503.00 *</td>
</tr>
<tr>
<td>Distributable Amount:</td>
<td>83,186.00 *</td>
</tr>
<tr>
<td>Type of Activity:</td>
<td>Service</td>
</tr>
<tr>
<td>Type of Award:</td>
<td>Grant</td>
</tr>
<tr>
<td>Type of Action:</td>
<td>Add Time and Money *</td>
</tr>
</tbody>
</table>

**Comments:**

- **Sequence 2 means that this is the 2nd award action on this account.**
- **Date action was approved by OCGA.**
- **Sponsor (funding agency) award number.**
- **Asterisks indicate any changes that occurred in this award action.**
## Institute Proposal Icons

The following icons display in the second row when you select the Institute Proposal Module.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Create New Institute Proposal" /></td>
<td>Used to create a new institute proposal from the Proposal Log. In most cases, Institute Proposals are created when Development Proposals have been approved and submitted by ORA.</td>
</tr>
<tr>
<td><img src="image" alt="Correct Institute Proposal" /></td>
<td>Used to make changes to an institute proposal. ORA only.</td>
</tr>
<tr>
<td><img src="image" alt="Display selected Institute Proposal" /></td>
<td>Opens the proposal in display mode. Doesn’t allow for any changes.</td>
</tr>
<tr>
<td><img src="image" alt="Institute Proposal New Entry" /></td>
<td>Opens the Proposal New Entry window with a new entry or sequence number. Used to “unfund” a proposal. ORA only.</td>
</tr>
<tr>
<td><img src="image" alt="IP Review" /></td>
<td>UM is currently not using this functionality.</td>
</tr>
<tr>
<td><img src="image" alt="Negotiation" /></td>
<td>UM is currently not using this functionality.</td>
</tr>
<tr>
<td><img src="image" alt="Notepad" /></td>
<td>Opens the Notepad window and allows the user to add a comment and restrict viewing of the note.</td>
</tr>
<tr>
<td><img src="image" alt="Medusa" /></td>
<td>Opens the Medusa window-Award, Subaward, Institute Proposal and Development Proposal links to show the relationships among them. Allows one to move from one module to the next without opening each separate module. User can view all details about the award, subaward and institute proposal using the details icon.</td>
</tr>
<tr>
<td><img src="image" alt="Sort Institute Proposals" /></td>
<td>Opens the Sort window and allows for sorting multiple columnar contents- ascending and descending</td>
</tr>
<tr>
<td><img src="image" alt="Search" /></td>
<td>Opens the Search window so users can search for Institute Proposals</td>
</tr>
<tr>
<td><img src="image" alt="Save As" /></td>
<td>Exports data into a MS Excel format</td>
</tr>
<tr>
<td><img src="image" alt="Close Institute Proposal" /></td>
<td>Closes the current Institute Proposal module.</td>
</tr>
</tbody>
</table>
Institute Proposal Search

To navigate to the Institute Proposal Search Window, click the Institute Proposal Module Icon or from the Menu Bar, click Maintain > Institute Proposal.

Institute Proposal Search Window:
You can search for Institute Proposals from the following categories:

- **Proposal Number**: 8-digit number consisting of 2-digit Fiscal Year, 2-digit Fiscal Month, (NOT calendar month) and 4-digit Coeus-generated sequential number. The Institute Proposal counter is reset each July 1 to indicate the new fiscal year.
  (e.g. 12010257 – This proposal was submitted in Coeus in the FY12, the first month of the fiscal year (July), and its proposal number is 0257.)

<table>
<thead>
<tr>
<th>Fiscal Year</th>
<th>Fiscal Month</th>
<th>Calendar Year</th>
<th>Calendar Month</th>
<th>Search Proposal #</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>01</td>
<td>2014</td>
<td>07 (July)</td>
<td>1501*</td>
</tr>
<tr>
<td>15</td>
<td>02</td>
<td>2014</td>
<td>08 (August)</td>
<td>1502*</td>
</tr>
<tr>
<td>15</td>
<td>03</td>
<td>2014</td>
<td>09 (September)</td>
<td>1503*</td>
</tr>
<tr>
<td>15</td>
<td>04</td>
<td>2014</td>
<td>10 (October)</td>
<td>1504*</td>
</tr>
<tr>
<td>15</td>
<td>05</td>
<td>2014</td>
<td>11 (November)</td>
<td>1505*</td>
</tr>
<tr>
<td>15</td>
<td>06</td>
<td>2014</td>
<td>12 (December)</td>
<td>1506*</td>
</tr>
<tr>
<td>15</td>
<td>07</td>
<td>2015</td>
<td>01 (January)</td>
<td>1507*</td>
</tr>
<tr>
<td>15</td>
<td>08</td>
<td>2015</td>
<td>02 (February)</td>
<td>1508*</td>
</tr>
<tr>
<td>15</td>
<td>09</td>
<td>2015</td>
<td>03 (March)</td>
<td>1509*</td>
</tr>
<tr>
<td>15</td>
<td>10</td>
<td>2015</td>
<td>04 (April)</td>
<td>1510*</td>
</tr>
<tr>
<td>15</td>
<td>11</td>
<td>2015</td>
<td>05 (May)</td>
<td>1511*</td>
</tr>
<tr>
<td>15</td>
<td>12</td>
<td>2015</td>
<td>06 (June)</td>
<td>1512*</td>
</tr>
</tbody>
</table>

- **Proposal Type**: New, Continuation, Revision, Renewal – Grants.gov application types
- **Status**: Pending, Funded, Not Funded by Sponsor, Deactivated, Withdrawn, Inactive, Expired 18 months-Sponsor no Action, Replaced by Later Proposal, Not Awarded-Unacceptable Terms
- **Account Number**: 7-digit KFS number (omitting leading 01-)
- **Title**
- **Department Number**: same as Unit Number
- **Unit Name**: same as Department Name
- **Investigator** – searches for any investigator- PI or Co-Pi
- **Sponsor Code**: 6-digit computer generated number
- **Sponsor Name**
- **Merged Proposal** – This feature is not used
Institute Proposal Tabs

Enter a proposal number in the search window, click **Find**.

Your search results will display. Double click the proposal you wish to open or click the **Display Proposal Module**.

*Proposal* – contains general information about the proposal.
**Mailing Info** – contains information about the due date, who submitted the proposal, Sponsor address, and electronic system information.

**Investigators** – contains PI name and departments. Lead PIs are indicated by check marks. The “effort” cells do NOT contain Credit Split information. Those cells are used in submitting proposals to Grants.gov. Credit Split info can be found by clicking on the **Credit Split** button. By double clicking on any name you will see their office location, phone number, email address, etc.

Double click a name to pull up their office information.
The Credit Split button on the Investigators tabs located on the right side of the page.

Cost Sharing – contains information if the proposal has any cost sharing associated with it.

IDC Rates – contains information about the indirect cost rates (aka Facilities & Administrative costs) for this proposal. UM’s F&A rate was renegotiated with DHHS and took effect 7/1/2011. New rates can be found here-
*Special Review* – Contains information on the items under Special Review (example IRB, IACUC, export control, conflict of interest, etc.)
Medusa

Medusa is a tool that shows the relationship among development proposals, institute proposals (submitted to sponsor), awards and subcontracts. The icon is on the lower level toolbar. It also allows you to view proposals from the award module and vice versa.

This view shows you the proposal to award relationship. The award (with $ sign) is highlighted so you see a summary of the award account.

The view below shows the Institute Proposal summary information. The Institute Proposal number is highlighted.

To get a detailed view of the item you have highlighted, click the Display Details Icon.
Subcontract Module

[Please note that the terms “Subcontract” and “Subaward” are used interchangeably and mean the same thing for the purposes of these guidelines.]

To access Subcontract Module, click the Maintain Subcontract icon from the menu bar or select the Menu Maintain → Subcontract.
To view or maintain an existing subcontract, enter the search criteria in the *Subcontract Search* window. Click **Find**.

Search results will appear on the *Subcontract List* screen, seen in the background.
Subcontract Icon Menu Bar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon" alt="Create New Subcontract" /></td>
<td>[ORA Use Only] Creates an initial subaward.</td>
</tr>
<tr>
<td><img src="icon" alt="Edit Subcontract" /></td>
<td>[ORA Use Only] Makes changes in a subaward. <strong>NOTE:</strong> Do not maintain money here. All money actions require a New Entry.</td>
</tr>
<tr>
<td><img src="icon" alt="Display Subcontract" /></td>
<td>Opens the subaward in display mode. Doesn’t allow for any changes.</td>
</tr>
<tr>
<td><img src="icon" alt="Subcontract New Entry (seq)" /></td>
<td>[ORA Use Only] Opens the Subcontract New Entry window with a new entry or sequence number. Sequences are like ATSs in RAA.</td>
</tr>
<tr>
<td><img src="icon" alt="Sort Subcontract (list)" /></td>
<td>Opens the Sort window and allows for sorting multiple columnar contents - ascending and descending.</td>
</tr>
<tr>
<td><img src="icon" alt="Search Subcontracts" /></td>
<td>Opens the Select Subcontract window so users can search for subawards.</td>
</tr>
<tr>
<td><img src="icon" alt="Save" /></td>
<td>Exports data into a MS Excel Spreadsheet.</td>
</tr>
<tr>
<td><img src="icon" alt="Close" /></td>
<td>Closes the current subcontract window.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon" alt="Next Subcontract" /></td>
<td>Displays the next subaward.</td>
</tr>
<tr>
<td><img src="icon" alt="Previous Subcontract" /></td>
<td>Displays the previous subaward.</td>
</tr>
<tr>
<td><img src="icon" alt="Print Subcontract Forms" /></td>
<td>Opens a window and you select the forms/letters you wish to print.</td>
</tr>
<tr>
<td><img src="icon" alt="Save" /></td>
<td>Exports data into a MS Excel Spreadsheet.</td>
</tr>
<tr>
<td><img src="icon" alt="Close" /></td>
<td>Closes the current subaward window.</td>
</tr>
</tbody>
</table>
Subcontract Search (Subaward)

- Open the Subcontract module by clicking on the **Maintain Subcontract** icon or select Menu **Maintain → Subcontract**.
- Enter search criteria for the subcontract (such as **Subcontract Code** = Coeus generated Subcontract number, **Purchase Order Num** = Subaward Number, **Subcontractor Name**, etc.) in the **Subcontract Search** window then click **Find** button.

**Search Criteria:**

1. **Subcontract Code** – Coeus generated subcontract (subaward) number
2. **Subcontractor Id** – Coeus generated subcontractor’s Id number (# specific to the organization)
3. **Subcontractor Name** – Subcontractor’s name
4. **Start Date** – Subaward start date
5. **End Date** – Subaward end date
6. **Subaward Type** – Subaward type (e.g. Grant, Contract, Cooperative Agreement, etc.)
7. **Purchase Order Num** – Subaward number (Q######, Z######)
8. **MIT Award Num** – Coeus generated Award number of Funding Source (Prime Award)
9. **Title** – Subaward Title
10. **Subcontract Status** – Subaward status (e.g. Active, Close, Inactive, Void, etc.)
11. **Account Number** – KFS number (without 01 in front)
12. **Vendor Number** – The Compliance Team may use this field in the future.
13. **Person** – Departmental Business Administrator who initiated the subaward or modification
14. **R. Unit Num** – The department(unit) number of the Requisitioner – Example: 1282501
15. **Unit Name** – Unit name of the Requisitioner – Example: BSOS-Psychology
16. **Archive Location** – Location where subaward documents are archived (not used)
17. **Closeout Date** – Date of final closeout.
• Perform a search and open the desired subcontract. **Display Subcontract** window will appear.

- Browse the subcontract record by clicking the tabs on top of the display window.
- To close the subcontract window, click on the **Close** icon or **box in the upper right corner.**
Subcontract
This tab contains general information about the Subcontract.

1. **Subcontract Code** – The unique identifying number of the Subcontract assigned by Coeus.

2. **Seq. No.** – Coeus generates a sequence number when a new Subcontract is created or a new entry is made to an existing Subcontract. The Sequence number will default to 1 when the Subcontract is first created.

3. **Status** – Current status of the Subcontract. The following are the status options that can be selected:
   - Active – fully executed
   - Closed – closed but paper files are still kept in Subcontract office (Compliance Administrator’s office)
   - Inactive – should not have been created
   - Archive – not used
   - Void – irresolvable negotiation issue
   - Pending within ORA – negotiation in progress, ORA has subcontract forms (not used)
   - Pending with Sub – negotiation in progress, sub has forms (not used)

---

**Double-clicking Subcontractor field will bring up Maintain Organization window.**

**Double-clicking Requisitioner field will bring up Person Details window.**

**Double-clicking Requisitioner Unit field will bring up Unit Details window.**
4. **Account No.** – KFS Account number which is funding the subcontract minus the 01 in front.

5. **Subcontractor** – The name of the Subcontractor (Subcontractors are found in the Organization table). ‘Temp Org-Subcontractor’ is used in case the actual Subcontractor is not available at the time of data entry.

6. **Start Date** – The date the Subcontractor’s project begins.

7. **End Date** – The date the Subcontractor’s project terminates.

8. **Subaward Type** – The type of Subcontract. These values are the same as those found in the award type dropdown:
   - Consortium Membership
   - Contract
   - Cooperative Agreement
   - Equipment Loan
   - Grant
   - Indefinite Delivery Contract
   - Intergovernmental Personnel Assignment
   - Material Transfer Agreement
   - Memorandum of Understanding
   - Non Disclosure Agreement
   - Other Transaction Agreement
   - Teaming Agreement

9. **Purchase Order Number** – UMCP uses this field to enter the **Subaward Number**. Subaward Number is assigned by the CA using the KFS Account number (Z prefix for Federal, Q prefix for non-Federal).

10. **Title** – The title of the Subcontractor’s project.

11. **Requisitioner** – The Departmental Administrator who initiated the Subaward Request of Modification.

12. **Requisitioner Unit** – The department associated with the Requisitioner on the Subcontract. The field includes unit number and name and is automatically populated by Coeus when the Requisitioner is selected.

13. **Vendor Number** – Institution specific number of vendor used in the Subcontract. – This will be blank unless the Compliance Team decides to use in the future.

14. **Closeout Date** – Date Subcontract was closed. This field is filled by the Compliance Team.

15. **Archive Location** – Archive Location of the physical files. – This will be blank unless the Compliance Team decides to use in the future.

16. **Comments** – Any additional notes about the Subcontract.

17. **Obligated Amount** (Read Only) – Amount requested by the Subcontractor. Populated by Coeus when it is entered in the [Amount Info] tab.
18. **Anticipated Amount** (Read Only) – Projected amount of funding over the life of the Subcontract. Populated by Coeus when it is entered in the [Amount Info] tab.

19. **Available Amount** (Read Only) – Calculated by subtracting the Amount Released from the Obligated Amount. UMCP does NOT use this field currently.

20. **Amount Released** (Read Only) – Cumulative amount of funds released to the Subcontractor. The amounts are entered on the [Amount Released] tab. – UMCP does NOT use this field currently.

**Funding Source**

This tab identifies the award that the Subcontract has been issued against.

<table>
<thead>
<tr>
<th>Award Number</th>
<th>Account Number</th>
<th>Status</th>
<th>Sponsor</th>
<th>Amount</th>
<th>Final Expiration Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>011128-001</td>
<td>525225</td>
<td>Approved</td>
<td>913051: USGS-Cooperative State Research...</td>
<td>$215,575.00</td>
<td>01-Aug-2011</td>
</tr>
</tbody>
</table>

1. **Award Number** – The unique identifier of the award that is assigned by Coeus.
2. **Account Number** – The KFS account number assigned to the award that is funding the Subcontract.
3. **Status** – The current status of the award funding the Subcontract.
4. **Sponsor** – The prime sponsor of the award funding the Subcontract.
5. **Amount** – The obligated amount of the award funding the Subcontract.
6. **Final Expiration Date** – The termination date of the award funding the Subcontract.
7. **Medusa** – The Medusa tool in Coeus displays the connection between the proposals that have funded each award and the subcontracts that are associated with those awards. Summary information about each related proposal, award, and subcontract is displayed in Medusa.

a. To open Medusa, click on the Award to highlight then click the **Medusa** button.
b. The Medusa window will open in View mode with summary information.

c. To view the award details, click on the award number in the left side of the Medusa panel below the View section. Then click on **Open selected item in view mode** icon or select the Menu View → Display.
d. Click on the tabs to navigate the award details.

e. To close the Medusa and go back to the Funding Source tab, click or Close icon.
Amount Info

This tab contains information about the obligated and anticipated amounts for the Subcontract.

1. **Obligated** – The amount requested by the subcontractor.
2. **Anticipated** – The projected amount of funding over the life of the subaward.
3. **Released** – Amount which has been obligated to the Subcontractor to date. – UMCP does NOT use this field.
4. **Available** – Amount of funds still available to provide to the Subcontractor. – Available amount is same as Obligated amount at UMCP.
5. **History of Changes** – This section details the history of Subcontract activity e.g. subaward initial setup, modifications, corrections etc. The following information is shown for each “transaction”:
   - **Line No** – The “transaction” number; assigned by Coeus.
   - **Effective Date** – The Effective date of this transaction
     - a. For a new subaward setup – Subaward Start Date
     - b. For modifications – the Most Recent Signature Date found on External Subaward Amendment forms
   - **Obligated** – The amount of funds obligated in this transaction.
     - a. For a new subaward setup – Amount obligated this action
     - b. For modifications – Additional or reduced funding amounts for this transaction. Zero (0) if the modification is not regarding changes in funding.
   - **Anticipated** – Total amount of funds projected over the life of subaward.
     - a. For a new subaward setup – Total anticipated amount (if incrementally funded). If not incrementally funded, the Obligated amount is repeated in this Anticipated field.

Total line displays the aggregate totals of all change entries.
b. For modifications – Additional or reduced amount of Total Anticipated amount. Zero (0) if the modification is not regarding changes in funding.

- **Comments** – Details about this transaction; e.g. set up a new subaward, extend the End Date, request for additional funding, etc. Standard format for transactions is ‘Seq # - Mod #, action details, Initial, Date’.

6. **Total** – The *Total Obligated* and the *Total Anticipated* amounts for all transactions of the Subcontract.

**Contacts**

This tab details the organizational contact for the Subcontract.

1. **Contact Type** – Type of Subcontractor Contact. – It will be always ‘Administrative Contact—2’.

2. **Name/Organization** – Name of the Subcontractor Contact selected from Rolodex. – ‘Temp Org-Subcontractor’ is available as a choice when the Subcontractor Contact is not available at the time of data entry.

3. **Contact Details** – This section displays the rolodex entry for the Subcontractor Contact selected. A Subcontractor Contract (Rolodex) is created for each Subcontractor (Organization). Its Address Line1 will be ‘Office of Sponsored Programs’ and the rest of details should be based on OSP’s main address and contact numbers as much as possible.
Closeout

The Closeout tab will be used to record closeout requirements of the subaward.

1. **Closeout Type** – Closeout types are selected from the dropdown list.
2. **Date Requested** – Requested date for the Closeout Type selected.
3. **Date Follow-up** – Date ORA will follow up on the closeout type selected.
4. **Date Received** – Date the actual closeout information was received for the selected type.
5. **Comments** – Additional comments regarding the closeout types used for closeout.
Others

This tab contains custom fields that are specific to UMCP and the questions will be answered based on the Subaward Checklist completed by ORA Contract Administrators/Subaward Administrators.